
Welcome to DeltaGraph 6!
22 February 2015:
DG Mac 6.0.20 Build 1 notes:

This version is a 32-bit Intel Binary, which will run on Mac OS 10.5 and later 
(including 10.10.x).

What’s New:
Changes: 

1. Resolved selection of chart elements in the Chart view.

1 November 2014
DG Mac 6.0.20 Build 1 notes:

This version is a 32-bit Intel Binary, which will run on Mac OS 10.5 and later 
(including 10.10.x).

What’s New:
Changes: 

1. Resolved Crasher in Yosemite 10.10.0
2. EPS Export is currently (11/1/14) broken in Yosemite; we are working with 

Apple to resolve this issue.



30 September 2013
DG Mac 6.0.19 Build 1 notes:

This version is a 32-bit Intel Binary, which will run on Mac OS 10.5 and later 
(including 10.9.x).

What’s New:
Changes: 

1. Fixed issue that caused text created with the text tool to be fractionally 
the wrong size (i.e., 8.6 points instead of 9 points, for example). This was 
usually only visible when exporting as pdf of epsf, and then opening the 
resulting file in Illustrator.

2. Other bug fixes. 
3. No longer include Pantone™ color swatch files in DeltaGraph distribution.
4. No Longer support PowerPC Macs.

Using Supported Color Swatch files with DeltaGraph 6:
Color swatch files in the .acb and .ai file formats can be used by DeltaGraph. In 
order to use color swatch files of these types, make a copy of the desired 
swatch files in the “Color Swatches” folder inside the DeltaGraph application 
folder.



24 September 2012
DG Mac 6.0.18 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.7.x).

What’s New:
Changes: 

1. Fixed issue that causes earlier version to hang at launch (after launching 
successfully once per login) on Mac OS X 10.8.2

2. Fixed an issue that prevented some complex, large files from being 
opened. 

23 February 2012
DG Mac 6.0.16 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.7.x).

What’s New:
Changes: 

1. Returned built-in symbols that were removed in version 6.0.12

7 February 2012
DG Mac 6.0.15 Build 4 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.7.x).

What’s New:
Changes: 

1. Improved Activation dialogs displayed when no Internet connection is 
available.

2. New activations should be more robust with respect to hard disk 
reformatting (Boot drive reformat, then restore software should no longer 
typically require reactivation of DeltaGraph).

3. Fixed: Issue that sometimes caused some DeltaGraph 6 files generated 
by the  Windows version to not open in the Macintosh version.

4. Fixed: When saving opening a file with multiple backgrounds, only the 



Master Background would be properly connected to the drawing canvases.
5. Fixed: When editing text areas in files created by DeltaGraph 5, font info 

for fonts with non-ASCII names would be lost.
6. Fixed: Formula Builder crashes when data sheet names are too long.



22 December 2011
DG Mac 6.0.14 Build 3 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.7.x).

What’s New:
Changes: 

1. Fixed issue with rendering of contour fill charts
2. Fixed issue that prevented updater downloads from being stopped.
3. Fixed issue with drawing contour fill charts
4. Fixed issue with opening, then saving, certain files created with earlier 

versions of DeltaGraph (5.x and earlier)
5. Improved conversion of non-ASCII text when opening version 5.x and 

older files



22 November 2011
DG Mac 6.0.12 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.7.x).

What’s New:
Changes: 

1. Fixed issue with export of text areas to eps. Text areas were being 
rasterized when exported to encapsulated postscript files. This has been 
fixed.

2. Improved application stability when opening version 5 and older files.
3. Fixed problem with entering negative numbers in multiple contexts within 

the application when running Mac OS X 10.5.8 (and possibly other 
versions of Mac OS X).

4. Sorted out inconsistencies between built-in symbols and the DeltaSymbol 
font, in the symbol popup in the Symbol Dialog.

5. Fixed problem with pattern fills in polygons.
6. Added Activation FAQs documentation to Help menu.

25 September 2011
DG Mac 6.0.11 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.7.x).

What’s New:
Changes: 

1. Fixed issue with creating and editing text areas when the main window is 
in split view mode. This issue would result in the text area being relocated 
far to the right of where it belonged.

2. Fixed issue with moving selected objects with the arrow keys in split view 
mode. The objects did not appear to move.

3. Fixed issue that caused symbols in 3D Scatter charts to be incorrectly 
placed.

4. Fixed issue with drawing 3D Pie Charts that caused the slices in the skirt 
to not line up perfectly with the slices in the top of the pie chart.

5. Fixed issue with editing backgrounds that could leave a chart page with no 
background at all.

6. Re-enabled colored (non-black) drop shadows for text areas.



7. Fixed issue with justification for text areas not being updated in the text 
menu and Set All… dialog.

8. Added checkbox in the “Select Number of Pages” dialog to apply the 
setting to all canvases.

9. Enhanced Document Info window, with more document information, along 
with the ability to remove unused backgrounds and layouts.

10. Moved Delete Page… and Name Page… menu items into the Edit menu.
11. Fixed issue with the “Check for Updates” functionality in Lion that caused 

it to simply not work.
12. Added ability to download the application updater from within DeltaGraph:

Click the Download Now button to download the updater, and the updater will 
download.



The disk image will be mounted automatically, and the updater package can be 
run by double-clicking it in its Finder Window (but first read the Read Me First 
file!).





18 August 2011
DG Mac 6.0.10 Build 3 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.7.x).

What’s New:
Changes: 

1. Fixed issue when opening some version 6 files created on Windows 
computers.

2. Resolved issue in the data sheet, where DeltaGraph would sometimes 
assume a single character (m, for example), was a date.

3. Resolved some issues preventing the opening of DeltaGraph 3.5 files. 
DeltaGraph 6 should now open files created with version 3.5 or later.

4. Resolved an issue that prevented DeltaGraph 6 from being able to open 
some files with the .dgp filename extension.

5. Resolved an issue with activation code that was producing the same 
request codes from different computers.

6. Resolved an issue which caused DeltaGraph to crash when running ICL 
commands. ICL output is now PDF and PICT to the clipboard.

7. Resolved an issue when editing colors in RGB mode which caused the 
CMYK version of the color to be trashed.

8. Added a feature to Legend settings which allows the user to tighten the 
spacing between the legend symbol and its label. This is accessible in the 
Legend Options dialog. Negative numbers reduce the distance between 
the legend symbol and its label, while positive numbers increase it:



12 July 2011
DG Mac 6.0.9 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.6.x).

What’s New:
Changes: 

1. Fixed issue which caused minor horizontal misalignment of symbols on 
two-dimensional charts, when the symbol size was less than 12 points.

2. Fixed crasher when reading some files.
3. Corrected legend for Paired XY line charts. Legend now correctly uses the 

label for the value columns.
4. New option for optimizing line chart drawing. This option (on by default) 

can speed drawing of line charts (with no symbols shown) by as as much 
as 10 times for charts with more than 5000 or so data points. Drawing is 
subtly different: ends of the lines, as well as all corners, will be rounded, 



rather than sharp. In order to provide compatibility with the old style 
drawing, the option to turn off this behavior is included in the Drawing pane 
of the application preferences. In addition, if a dash style is chosen for the 
line, and "Round Ends" is not chosen, the optimization will be disabled.

4 May 2011
DG Mac 6.0.8 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.6.x).

What’s New:
Changes: 

1. Fixed several issues with AppleScript support.
2. Fixed problem reading DeltaGraph files created by DeltaGraph for 

Windows versions earlier than 5.0

14 March 2011
DG Mac 6.0.7 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.6.x).

What’s New:
Changes:

1. Fixed problem with dates imported from Excel files that use the “1904 
Date System”, typically only some Excel files created on Mac OS. The 
symptom is dates that are 4 years and 1 day too early. 

2. Fixed problem rendering chart labels which have multiple super and/or 
subscripts.

3. Fixed crasher: Clicking “Revise Data” toolbar button when no chart is 
selected

4. Fixed: “Chart Options” and “Error Bars” toolbar buttons would sometimes 
do nothing.

5. Made several improvements to the data sheet view:
⁃ Enter key works as return key
⁃ When multiple cells are selected, tab and enter/return keys move 

around the selection
⁃ Home and End keys are now functional.
⁃ When entering dates and times in DeltaGraph standard formats, the 



data sheet does a better job of parsing them into date/time data, 
rather than leaving them as character strings.

6. Added several command-key shortcuts:
⁃ Moving between Views (data -> chart -> sorter, for example)

⁃ ⌘⇧[ : Previous View
⁃ ⌘⇧[ : Next View

⁃ Moving between Sheets (data#1 -> data#2, for example)
⁃ ⌘⇧+ : Previous Sheet
⁃ ⌘⇧- : Previous Sheet

11 January 2011
DG Mac 6.0.6 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.6.x).

What’s New:
Changes:

1. Fixed problem with drawing in data sheets when column widths were set to 
be too small to fit the a single character.

2. Fixed problem with drawing the sheet popup (when clicked) where the 
selected data sheet had a long, non-Roman title.

3. Fixed: Could not change fill pattern for label text.
4. Fixed: Issue with saving some version 5.x and earlier files.
5. Fixed: Issue with contour labels disappearing when saved to a library.
6. The “Chart” toolbar item now works as in version 5.x: a click works like the 

“Chart Gallery” menu item, while a click and hold brings up a popup menu 
with options.

23 November 2010
DG Mac 6.0.5 Build 6 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.6.x).

What’s New:
Changes:

1. Fixes for editing of rotated text blocks. Rotation is preserved, and no more 
crashes.

2. Fixed issues with importing data that includes dates and / or times. These 



would formerly be imported, but when edited would appear as unformatted 
numbers.

3. Control over alignment of labels with superscripts and subscripts. 
Normally, labels are aligned so that their tops are aligned. With the 
changes in this version, the labels can optionally be aligned by their 
baselines. To change the alignment of labels for a chart, select the chart, 
and press Command-Option-R. To change back to the default alignment, 
hit Command- Option-R again.

4. Corrected some Japanese - localized tool tips.
5. Removed the Text Shadow button from the Object Attributes dialog, so 

that only the object Shadow button is available. This button works for all 
objects.

6. Fixed the Shadow button in the Set All Text dialog so that it works with 
both label text and text blocks made with the text tool.

7. Fixed problem writing SOME files containing text blocks. Text blocks 
would initially display incorrectly when the file was opened on Windows.

8. Initial release of Japanese language version.
9. Fixed problems with crumpled text in activation process on Japanese 

systems.
10. Fixed calculation of size for built-in symbols. Previously, the font metrics 

of the last selected font were used to calculate the size of the built-in 
symbol. Now, a standard size (equal to the font size) is used.

11. Fixed crasher when trying to select one of the charts in a multichart chart 
(QC XBar-R, for example)

12. Changed the Headers and Footers dialog to use the actual page name of 
the current page when displaying a sample

13. Fixed problem with drawing symbols in 3-d scatter charts.
14. Fixed problem which prevented graphics export from the Organizer View.
15. Fixed a couple minor issues inside the Symbols dialog.
16. Fixed a problem that would sometimes cause crashes when rendering 

built-in symbols
17. Fixed problem with “Revert” menu item with files with non-Western 

filenames
18. Fixed crasher when trying to save to a write-protected directory

26 October 2010
DG Mac 6.0.4 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 



later (including 10.6.x).

What’s New:
Changes:

1. Made the New Chart toolbar button available in the Data view. To add it, 
control-click on the toolbar, select Customize Toolbar from the popup 
menu, and select the default toolbar icons.

2. Fixed drawing issue in the chart popup menu in the Overlay dialog
3. Fixed issue with version 6 libraries, where charts with custom axis 

settings would sometimes have their axis setting scrambled when used.
4. Fixed problem with reading some files created on Macintosh computers 

with different endianness (i.e., Intel Mac reading PowerPC Mac file, or 
PowerPC Mac reading Intel Mac file).

5. When creating a new Chart sheet, the view scale will be copied from the 
first Chart sheet.

6. Better messages when working with libraries created with earlier versions 
of DeltaGraph

7. Fixed issue with Object Attributes dialog which would sometimes cause a 
fatal error.

8. Fixed out of memory condition when reading / writing files with large data 
sheets.

29 September 2010
DG Mac 6.0.3 Build 1 notes:

This version is a 32-bit Universal Binary, which will run on Mac OS 10.5 and 
later (including 10.6.x).

What’s New:
Bug Fixes:

1. Fixed problem saving files with long filenames
2. Fixed problem with the Organizer: Only chart pages created since the last 

time the file was opened appear in the organizer, and new blank chart 
pages are sometimes created.

3. Fixed problem with updating the chart popup menu which caused duplicate 
entries in the popup. Selecting the first duplicate entry in the popup menu 
usually caused a crash.

4. Fixed problem with reading some data sheets with sparse data. This 
problem would sometimes cause a crash, especially when recalculating 
cell formulae.



5. Fixed problem where sometimes the number 0 was handled as text in the 
data sheet.

6. Fixed issue with number formatting in dialogs when the system is 
configured to use “,” as the decimal separator.

7. Fixed problem reading some version 5 Mac files, when opened on a 
different hardware platform (i.e., file created on PowerPC Mac, opened on 
Intel Mac, or file created on Intel Mac opened on PowerPC Mac).

8. Fixed Document Info dialog. Filenames and paths with non-roman 
characters were incorrectly displayed

9. Fixed problem which prevented using the Font Window from within the Set 
All Text dialog and the Object Attributes Dialog

10. Fixed problem with incorrect page names when headers or footers were 
used when printing the Chart View.

New Features:
1. Changed cell drawing behavior in the data view. Text that is too large for 

the cell dimensions is now truncated.
2. All objects in the Drawing view support Quartz shadows
3. Removed the Shadow menu item from the Text Menu.
4. Current shadow behavior:

⁃ Text created with text tool:
⁃ Drop, Quartz shadows
⁃ Drop shadows do not support color or patterns

⁃ Chart labels, symbols:
⁃ Drop, Quartz shadows
⁃ Drop shadows do not support patterns or background colors

⁃ All other:
⁃ All shadow variations supported

10 September 2010
DG Mac 6.0.2 Build 1 notes:

What’s New:
Bug Fixes:

1. Oops! Fixed problem that may cause crashes when reading files with text 
created with the text tool.

7 September 2010
DG Mac 6.0.1 Build 1 notes:



What’s New:
Bug Fixes:

1. Fixed issue which made it impossible for some users to export text 
created with the text tool.

2. Fixed issue which caused drawing sheets larger than one page to be split 
into multiple drawing sheets when their document was opened.

3. Fixed problem with saving certain charts that included color blends in 
chart elements.

4. Fixed flickering of window toolbar when switching between views of the 
same type.

5. Fixed problem that caused some data sheets in some documents which 
had their series in rows to be incorrectly read as having their series in 
columns.

New Features:
1. Experimental support for import and linking to Microsoft Excel (including 

Excel 2008) worksheets. This feature is available from the Import… menu 
while in the Data view. When the standard Get File dialog appears, choose 
an Excel filetype from the popup menu at the bottom. There are no known 
limitations on this feature.

2. An old feature returns! Support for import of Cricket Graph data files! This 
works as it did in version 5.x: With DeltaGraph 6 running, in the Finder 
select a Cricket Graph data file, and drag it into a DeltaGraph data sheet. 
Respond to the dialog window that appears, and you’re done!

14 August 2010 
DG Mac 6 Build 5 notes:

What’s New:
1. New, more robust truly cross-platform file format.
2. Cross-application support for non-english text. No more issues with non-

ASCII characters.
3. New Multilingual Text Editor, based on Apple Text Edit.
4. New EPS export fully duplicates DeltaGraph on-screen drawing, and 

includes sub-setted fonts, making the files more portable to other 
applications.

5. PDF support for spot colors.
6. Numerous bug fixes.
7. Interface changes:

⁃ Mac OS X – style UI



⁃ New, more modern icons for tools and buttons
⁃ The outliner is gone.
⁃ Document window now supports gestures and scroll wheel.
⁃ Document Setup is gone, now use Page Setup for the Data and 

Chart Views.
⁃ Most of the Layout submenu, formerly located in the Edit menu, has 

migrated to the View menu.
⁃ The Sorter has become the Organizer.
⁃ The Slide Show, and related features are gone.
⁃ Org Chart chart type is no longer available
⁃ Obsolete preferences have been removed from the Preferences 

Window.
8. Vector PICT type is no longer available as an export type, as we no longer 

support QuickDraw – style drawing

Limitations in version 6:

1. DeltaGraph 6.0 cannot import data from Microsoft Excel files. This issue 
will be resolved early this fall in a free update to DeltaGraph 6. In the 
meantime, the workaround is to save Excel files as Text from within the 
Excel application.

2. EPS export of content that includes Quartz – style blends contain 
Postscript errors. This issue is caused by a limitation of Apple’s 
Postscript writer in Mac OS X 10.6.4 and earlier. Apple has been made 
aware of this issue. The workaround for now is to not use Quartz - style 
blends in content that will be exported as EPS.


